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Conform to the following specifications: 
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and is CE marked accordingly. 
 

Signature:     
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WEEE Regulations 2006 
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1. Introduction 
 
The Rapidox 2100ZF (Z = Zirconia F= Front Mounted Sensors) oxygen analyser 
allows fast and accurate oxygen analysis over the full oxygen range (10-20ppm to 
100% O2).  The Rapidox provides continuous on-line oxygen analysis, with a 
typical response time of less than 4 seconds for a 90% response to a step change in 
gas compositions. 
 
The sensor head comprises a zirconia ceramic tube, which is heated up to 650°C 
in order for it to conduct oxygen ions.  Power for the sensor heater is supplied and 
accurately controlled by a regulated power supply incorporated in the analyser. 
 
The analyser is packed with features including programmable alarm circuits, 
programmable analogue outputs, easy calibration (user selectable gases), RS232 
communications and complete communications / data logging software. 
 
Additional sensors may be attached via the auxiliary socket which will read most 
standard 4-20mA transmitters.  Currently the Rapidox can be configured to read 
pressure, vacuum and dew-point sensors.  Others can be adapted on request. 

2. Features 
 
 Very fast measurement response (typically 1-4 seconds for a 90% response). 

 
 Full measurement range available (10-20ppm to 100% O2). 

 
 Accuracy ± 1% of the actual measured oxygen with a precision of ± 0.5%. 

 
 Easy calibration procedure requiring any two or three gas mixtures (air is 

usually one). 
 

 Independent Type K thermocouple fitted as standard 0-1250°C. 
 

 Simple installation, low maintenance, sensor life expectancy typically 17,500 
hours.  Pre-calibrated sensors available. 
 

 Large back-lit LCD display (16 x 2 characters). 
 

 RS232, 0-5V and 4-20mA current loop outputs (both programmable). 
 

 Fully programmable alarm circuits. 
 

 Full data logging software accessed via RS232 connection to a PC (RS485 
available on request). 
 

 Optional pressure, vacuum or dew-point sensor attachment 
 

 Helium & vacuum operating mode 
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3. Technical Specification 
 
 

Property Specification 
Supply Voltage 90-260VAC, 50/60Hz 
Power consumption 100W (max) 
Analyser dimensions W250mm X D263mm X H150mm 
Weight 3.5 kg 
Display 16 × 2 character (9mm) back-lit LCD 
Warm up time 3-4 minutes at 20°C 
Operating heater voltage 13-15V 
Normal operating temperature 5-35°C 
Outputs: O2 & temperature OR 

auxiliary 
0-5V (user-programmable) into minimum 
5kΩ 

 O2 & temperature OR 
auxiliary 

4-20mA current loop (user-programmable) 
into maximum 500Ω 

  High and low alarms Relay contacts – fully user-programmable 

  All data and parameters 
RS232 or RS485 - data streamed on 
demand 

Calibration 
Requires 2 or 3 user-selectable gas 
compositions (air is default plus another 
two) 

Thermocouple Type K fitted to standard compensated 
plug.  Range 0-1250°C, accuracy ± 1°C  

Table 1: Rapidox Analyser 

 
Property Specification 

Cable 
2m high temperature silicone sheathed 
cable, fully shielded.  Nickel quick release 
plug 

Max sustained gas temperature  650°C 
Temperature of metal housing 150 to 200°C  
Life expectancy > 17,500 hours 
Range of measurement 10-20ppm to 100% O2 

Response time (@ gas flow rate 1l.min-1) 
Approximately 4 secs for a 90% step 
change (e.g., from 21% to 100% O2) 

Accuracy ± 1% of the actual oxygen concentration 
Precision of measurement ± 0.5% of the reading 

Maximum working pressure 
10 bar (depends on gas and temperature) 
200 bar burst pressure 

Minimum working pressure Vacuum tight down to below 10-4 Torr 

Sensor Replacement  Pre-calibrated sensor can be supplied for 
immediate installation 

Table 2: Rapidox Sensor 
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4. Precautions 
 
Make sure you read and understand these instructions and keep them safe for later 
use.  The unit should not be exposed to extreme temperatures < -5°C or > 60°C.  
Normal operating temperature is 5-35°C.  Avoid direct sunlight.  Do not use liquid 
cleaners, aerosols or solvents to clean the case.  Use a damp cloth for cleaning.  Do 
not use this equipment near water.  Avoid touching the LCD display as this may 
cause permanent damage.  Make sure the rear ventilation slots and the fan on the 
rear panel are free of obstruction. 
 
There are no user serviceable parts in this unit.  Do not attempt to repair yourself.  
Refer all servicing to qualified Cambridge Sensotec personnel. 
 

5. Warning 
 
The sensor head and metal surroundings become hot (>100°C) during use and 
careful consideration should be taken to avoid the risk of burn injury. 
 
This unit is NOT designed for use in life support situations.  No responsibility can 
be held for injury or loss of life caused by inappropriate use of this equipment. 
 
 

6. Rapidox Operating Instructions 
 

6.1 Sensor Location 
 
The sensor head (see Figure 1) comprises a small tube of high purity zirconia, 
which becomes an oxygen conductor when heated to approximately 650oC (see 
Figure 2).  The ceramic can be damaged if the sensor head is knocked or dropped, 
so care must be taken when handling it. 
 
Select a suitable location for the sensor bearing in mind that the temperature of 
the measurement gas must be less than 650°C and ideally below 350°C where the 
sensor tip is located.  The outer part of the sensor must be in ambient air.  
Cambridge Sensotec can supply a selection of sensor housings (see Figure 3) to 
allow access in awkward situations, and if necessary a small pump can be 
installed to sample the gas remotely. 
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Figure 1: The zirconia oxygen sensor 

 

 
 

Figure 2: Oxygen sensor schematic, 1 = zirconia electrolyte, 2 = electrodes, 3 = 
contact, 4 = housing, 5 = sample pipe, 6 = ceramic protective coating (porous) 

 
 

5.00 mm
5.00 mm

M5 clearanace
holes straight through M18 1.5 pitch thread

22.50 mm

22.50 mm

30.00 mm
45.00 mm

45.00 mm

Top View

Side View

1/8" BSP tapered
thread (or NPT)

 

Figure 3: Schematic showing sensor attached to gas pipe adapter (supplied).  Gas flows across 
the sensor via pipes attached to the nipple fittings. 
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As with all electronic devices, the Rapidox sensor signal may be affected by strong 
electromagnetic noise interference although this has been minimised by careful 
shielding.  Please ensure that wherever possible, the sensor head and analyser are 
kept away from sources of electrical noise.  Ensure that the sensor cable is not 
touching any hot surfaces and is kept away from areas that are generating 
electrical noise.  The cable is designed to withstand temperatures of up to 150oC 
for short periods (<15 seconds). 
 
The sensor is threaded with an 18mm 1.5mm pitch thread, which is a standard tap 
size for automotive spark-plugs.  Ensure that the sensor is tightened down 
securely so that no gas can escape around the thread.  A selection of gaskets is 
available for different applications (e.g. working above pressures of 1 bar or under 
vacuum conditions).  The sample chamber is tapped with a 1/8” NPT tapered 
thread.  BSPT fittings will also fit this tap. 
 

6.2 The Rapidox Analyser - Front and Rear Panels 
 
 

 
Figure 4: Rapidox 2100Z front panel.  Numbers are referred to in the text. 

 

1 
2 

3 4 5 
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Figure 5: Rapidox 2100Z rear panel.  Numbers are referred to in the text 

 

6.3 The Rapidox Analyser - Menu System 
 
All of the user-programmable functions are accessed via a menu system which is 
controlled using the front panel Keypad (2).  To access the menu press the ENT 
button and to escape and return to the operating screen press ESC at any time.  
The menu system flow chart is shown in Appendix 1 at the end of this manual. 
 

7. Getting Started 
 
Ensure that the Rapidox analyser is located away from extreme heat and dirt 
environments.  Plug the unit in to a suitable supply (noting the information on the 
serial sticker and using the power cable supplied) using the rear power socket (8).  
Make sure that the cooling fan (9) is not obstructed during operation.  Connect the 
sensor plug to the front of the Rapidox using the 5-way Cannon type socket (3).  If 
you require temperature measurement ensure that the type K thermocouple is 
plugged into the type K socket on the rear panel (7).  If you are using an external 
pressure, vacuum or dew-point sensor connect this to the 3-way Cannon type 
socket labelled Auxiliary (4)  
 
Turn the unit on using the red power switch on the front (5).  The LCD (1) will 
display the firmware version and serial number followed by the message 
“HEATING SENSOR”.  The sensor will take approximately four minutes to come 
up to temperature, after which the Rapidox will begin to take measurements.  The 
progress of the sensor heater is shown in the form of a bar graph on the LCD (1). 
 
Allow thirty minutes for the box to stabilise fully.  This allows the components of 

6 
7 

8 9 

10 
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the analyser to reach a stable working temperature.  During this warm-up period it 
is common for the baseline oxygen to drift by a small amount, which may be 
corrected by re-calibrating. 

7.1 Display Behaviour 
 
Once at temperature the LCD display (1) will show the oxygen reading on line 1 
and the temperature / auxiliary sensor (if fitted) reading on line 2.  This can be 
changed to temperature, pressure or dewpoint if required (see section 7.9).  The 
lower right hand corner of the LCD will display the oxygen range selected 
(H=high, M=Medium & L=Low).  The symbol AL1 or AL2 may also appear to the 
bottom right of the LCD if the alarm system is enabled and an alarm condition 
applies.  A black circle  next to the word “O2” indicates that the unit is operating 
in Helium Mode (see 7.10).  The oxygen sensor reading may show U/Range or 
O/Range when its limits are reached, and error messages will be displayed if there 
is a fault with the sensor.  See Table 3 for more details: 
 

Oxygen Sensor Display Possibilities 
O2 Reading > 9999.9% Display shows “O/Range” 
O2 Reading > 10e-20ppm and < 9999.9% Display shows the normal oxygen reading in % or ppm 
O2 Reading < 10e-20ppm Display shows “U/Range” 
O2 Measurement is not within the H or M Range 
selected Display shows “Change Range” 

O2 Reading is flashing Indicates that the connected pressure sensor is out of range 
and automatic pressure correction is on. 

O2 Sensor takes > 10 minutes to warm up Display shows “Possible sensor Fault” because the sensor 
heater is failing. 

O2 Sensor has failed completely or become 
disconnected Display shows “No sensor or sensor Fault” 

O2 Sensor is OK but the pressure sensor (if fitted) is 
faulty and the auto pressure correction mode is 
selected 

Display shows “FAULT” flashing. 

Type K Thermocouple Display Possibilities 
Tc Reading > 1251°C Display shows “O/Range” 

Tc Reading > 1250°C Display flashes to warn the measurement limit is 
approaching 

Tc Reading > 0°C and < 1250°C Displays the normal temperature reading in °C or °F 
Tc Reading < 0°C Display shows “U/Range” 
Tc Sensor is disconnected Display shows “FAULT” 

Auxiliary Sensor (Pressure, Vacuum or Dewpoint) Display Possibilities 
Sensor Transmitter gives > 20.0mA signal Display shows “O/Range” 
Sensor Transmitter gives > 4.0mA and < 20.0mA Display shows the normal reading of the sensor connected 
Sensor Transmitter gives < 4.0mA Display shows “U/Range” 

 
Table 3: Different display possibilities depending on the sensor reading. 

 

7.2 Menu Access / Passwords 
 
The analyser has an option to set a password that will restrict access to the menus.  
The password menu is disabled by default in the factory.  If you wish to password 
protect the analyser press ENT and scroll down to the PASSWORD option (Menu 
option 14).  Pressing ENT again will ask you for the default password which is 
“0000”.  Enter this using the UP and DOWN arrows.  Once the password has been 
entered successfully you can choose between ENABLE and DISABLE in the menu 
using the UP and DOWN keys. 
 
The other option is to RESET the password to a new value.  The password must be 
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4 digits long and can be any combination of numbers from 0-9.  Make sure that the 
new password is noted down! 
 
If the password function has been enabled then in the future the password prompt 
will display each time the menu system is accessed.  After the correct password is 
entered then the full menu will be accessible.  You can make as many changes as 
you want to the different menu options and only press ESC once you have 
finished.  Pressing ESC takes you out of the password protected area and you will 
have to re-enter the password to go back in again.  Note that changes to a menu 
option will only be registered if the ENT button is used to complete the final step 
of the item – pressing ESC while stepping through an option aborts any changes 
made. 
 
If the password has been forgotten please contact Cambridge Sensotec who will 
advise you on how to recover it. 
 

7.3 Rapidox Calibration 
 
Once the unit is at temperature it may be necessary to calibrate the sensor.  Full 
calibration is a simple procedure requiring only two or three gases (one of which 
is normally air – 20.95%).  The three gas values are user-selectable during 
calibration and can be changed by using the front keypad (2) or the 
communications software described in section 8, and the calibration values can be 
stored on file for later use. 
 
Care must be taken to calibrate the analyser so that, whenever possible, the range 
of measurement lies between the two calibration point extremes.  For example, if 
you are working at 10ppm but have calibrated the analyser between 21% and 
100% then the analyser will be inaccurate.  You would need to calibrate at, say, 
1ppm and 21% to be sure of good accuracy.   The procedure is as follows: 
 
1) Bearing in mind the points made above, decide which two (or three) gases 

you are going to use for calibration.  If you are constantly working at a 
particular range of compositions then it would be wise to obtain small 
cylinders of calibration gas with analysis certificates.  Cambridge Sensotec 
can supply these.  Press the ENT button on the front panel keypad (2) to 
access the menu system.  The calibration function is option 1 on the menu 
list, which can be scrolled using the UP and DOWN arrows.  Press ENT 
again to enter the calibration menu.  Use the UP and DOWN arrows to 
select O2 HIGH, O2 MIDDLE or O2 LOW and press ENT to proceed.  The top 
line of the display shows the current calibration gas stored and the bottom 
line of the display shows the prompts.  If the gas value is not what you 
require you can edit the value (in ppm scientific notation – see Table 4) 
using the up and down and right arrows on the keypad.  The cursor flashes 
underneath the digit to edit. For example air (20.95%) should be entered as 
2.095E+05ppm (209,500ppm).  Note that you cannot go backwards to edit a 
digit to the left of the cursor.  Instead keep pressing the RIGHT button and 
the cursor will wrap around back to the beginning.  Alternatively press ESC 
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to start again.  Press ENT when you are ready to proceed. 
 

Scientific 
Format 

Meaning Equivalent 
ppm 

Equivalent 
Percent 

1.000E+06ppm 1.000 x 1,000,000 1,000,000ppm 100.00% 
2.095E+05ppm 2.095 x 100,000 209,500ppm 20.95% 
1.000E+05ppm 1.000 x 100,000 100,000ppm 10.00% 
1.000E+04ppm 1.000 x 10,000 10,000ppm 1.000% 
1.000E+03ppm 1.000 x 1,000 1,000ppm 0.100% 
1.000E+02ppm 1.000 x 100 100.0ppm 0.010% 
1.000E+01ppm 1.000 x 10 10.00ppm 0.001% 
1.000E+00ppm 1.000 x 1 1.000ppm 0.0001% 
1.000E-01ppm 1/10 0.1ppm 0.00001% 
1.000E-02ppm 1/100 0.01ppm 0.000001% 
1.000E-20ppm 1/100000000000000000000 0.00000000000000000001ppm 0.000000000000000000000001% 

Table 4: Examples of common scientific format with their equivalent ppm and percent values 
 

2) The sensor needs to be exposed to the first calibration gas from a cylinder 
(or exposed to ambient air, 20.95% if this is the calibration gas of choice).  
Allow several minutes to pass to flush the sensor properly.  Wait for the top 
line of the display (1) to become stable.  To complete the calibration press 
and hold the ENT button for two seconds.  During this time you will see a 
bar graph progress across the lower display.  The analyser will then 
recalibrate and display “O2 recalibrated” and then return to normal run 
mode.  The display will now correctly read the value of the first calibration 
gas.  Note that if the ENT button is released before two seconds have 
elapsed, the recalibration will be aborted and when the analyser eventually 
returns to run mode it will use the existing calibration. 
 

3) Note that the analyser should be calibrated at normal ambient pressure.  If a 
pressure sensor is fitted to the auxiliary socket AND the pressure correction 
mode is set to AUTO then it is still possible to perform an accurate 
calibration at pressures other than ambient.  However above 25mbar 
(gauge) or below -25mbar (gauge) the display will flash and “P?” will 
display to warn you that the pressure is either above or below the range 
recommended for accurate calibration. 
 

4) The analyser predicts the correct signal from the sensor during calibration 
and if this is outside the range of expected values then the display will flash 
and display “G?” to warn you that either the cal gas flowing over the sensor 
is different to the value you have programmed OR the sensor may be old 
and approaching the end of its life.  Check before proceeding! 
 

5) To calibrate against the second or third calibration gas, repeat the 
procedure from 2 but this time press ENT followed by the UP or DOWN 
button to scroll through to the “O2 Middle” or “O2 Low” screen.  Flush the 
sensor chamber with the second calibration gas allowing several minutes 
for the new gas to flush through.  Wait for the display to become stable 
before pressing the ENT button for two seconds.  The analyser will then 
recalibrate and display “O2 recalibrated” and then return to normal run 
mode.  The display will now correctly read the value of the calibration gas. 
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6) The analyser is now correctly calibrated and will read accurately between 
these two calibration points.  Note that this procedure can be performed 
remotely using the software described in section 8.  You can now repeat 
this process for the third calibration gas if required. 
 

7) If at any time, you encounter difficulties and wish to restore the machine to 
its factory set calibration, use the configuration software provided and load 
the default settings (described in section 8.4 below).  Each machine is 
provided with a unique file that contains the factory settings.  This is 
located on the CD-ROM provided and is copied onto your PC during the 
installation process. 
 

8) Note that the three calibration points are independent of each other so you 
can calibrate the analyser in any order you desire.  However please note 
that O2 HIGH must always be greater than O2 MIDDLE which must always 
be greater than O2 LOW.  Typically the factory settings are: O2 
HIGH=20.95%, O2 MIDDLE=0.1% (1000ppm) and O2 LOW=0.001% 
(10ppm). 

 
NB You must always perform a FULL calibration to achieve good accuracy.   

 

7.4 Cleaning the Sensor 
 
You can clean the sensor at any time by pressing ENT on the keypad and scrolling 
down to option 2 “Clean Sensor” or using the software described in section 8.7.  
Press the ENT button to proceed.  The screen displays “Clean Sensor?”.  Press ENT 
again and the cleaning will take place.  The procedure takes approximately five 
seconds and the LCD display shows the progress of the operation.  Once finished, 
the analyser will take a few seconds to re-stabilise.  The sensor is cleaned each 
time the unit is switched on prior to operation.  If you are operating in gases with 
large amounts of soot, there is a risk that the sensor surfaces will become 
contaminated with particulates, which will impair performance if allowed to build 
up.  The cleaning operation pumps oxygen through the zirconia tube, which burns 
the particulates away from the sensor surface. 
 

7.5 Oxygen Range 
 
The Rapidox 2100Z has three oxygen measurement ranges which can be 
programmed using the Keypad (2) or the software provided (section 8.5.1).  
Always select the most appropriate range in order to achieve maximum resolution 
from the analyser.  The three ranges are labelled HIGH, MEDIUM & LOW. 
 

1. High  from 0.1% to 100% oxygen 
2. Medium from 1ppm to 100% oxygen 
3. Low  from 10-20ppm to 100% oxygen 

 
The range currently in use is displayed in the bottom right hand corner of the LCD 
display by the character L, M or H.  To change the range select option 3 “Set O2 
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Range” and press ENT.  Use the UP & DOWN arrows to select the required range 
and press ENT to finish.  If the measurement is out of range then the display will 
flash with the message “Change Range” to warn you to change over to a lower 
range to continue reading. 
 

7.6 Alarms 
 
The Rapidox is fitted with two independent and fully programmable alarm relay 
outputs, which can be programmed to be either normally open (N/O) (closes on 
alarm) or normally closed (N/C) (opens on alarm).  You have the option of 
assigning each alarm to the oxygen, auxiliary or temperature sensors, as well as 
enabling the alarm relay circuits, enabling an audible buzzer and enabling a visual 
warning on the screen. 
 
The alarms can be programmed by the user via the keypad (2) on the front panel 
or using the software provided (section 8.5.2).  To change the alarm settings scroll 
down the menu to no. 4 “Set Alarms” and press ENT.  Now use the UP & DOWN 
arrows to select “Alarm 1” or “Alarm 2” and press ENT.  The next screen shows 
the message “Assign To:”.  Use the UP and DOWN arrows to select O2, AuxIn or 
Temp depending on which measurement you want the alarm to work with, and 
press ENT to proceed.  The default is O2.  
 
The next settings configure the behaviour of the alarm.  Use the UP & DOWN 
arrows to select ON or OFF for the following parameters: 
 

1. OUTPUTS:  This enables the rear panel relay outputs when ON is selected 
2. AUDIBLE:  This enables or disables the audible buzzer inside the unit 

which will sound in an alarm condition 
3. VISIBLE:  This enables or disables warning messages on the LCD screen on 

the front of the Rapidox.  During an alarm condition either “AL1” or “AL2” 
(or a combination of both) will flash at the bottom right hand corner of the 
display. 

4. POLARITY: This determines whether you are setting a rising or falling 
alarm.  Use the arrows to change the direction of the alarm to up or down.  
A rising alarm means that the alarm will be silent at values below the set-
point but as soon as the value rises above the set-point the alarm will be 
triggered 

5. SETPOINT: The current alarm set-point is displayed in scientific notation 
(see Table 4) with a flashing cursor under the first digit.  Use the UP & 
DOWN arrows to change the digit and the RIGHT arrow to progress until 
the correct value is displayed.  When done, press ENT to proceed to the 
next setting. 

6. CONTACTS: The relay outputs can be set to either normally open (N/O) or 
normally closed (N/C).  The factory default is N/O, meaning the contacts 
will close when an alarm condition occurs.  Press ENT to save all the above 
settings for the selected alarm. 

 
Alarm 2 can be set in exactly the same way as described above and both alarm 
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circuits are completely independent of each other.  Note that you must programme 
all the parameters for each alarm for the settings to be saved.  The bottom line of 
the LCD will display “Alarm x set” (where ‘x’ is the selected alarm channel) to 
confirm that the settings have been saved. 
 
The alarm circuit relays are accessed via the terminal block on the rear panel and 
are clearly labelled.  Alarm 1 is assigned to the terminals labelled “Alarm High” 
and Alarm 2 is assigned to the terminals labelled “Alarm Low”.  The relay circuit 
is rated at 24V 0.5amps maximum. 
 
The alarm limits for oxygen are set to a minimum of 10-20ppm and a maximum of 
1000%.  Under certain conditions (e.g. the sensor becomes disconnected) the 
Rapidox will set the alarm channel to OFF to prevent false alarms, and the relay 
contacts for the affected channel will go to the programmed N/O or N/C setting.  
For more information please refer to Table 4 in section 7.7 below. 
 

7.7 Analogue Outputs 
 
The Rapidox analyser provides various analogue outputs.  The standard industrial 
analogue outputs (0-5V and 4-20mA) for both oxygen, and temperature (or 
internal pressure) are accessible via the terminal block (6) on the rear panel.  
These outputs have a 12 bit resolution (approximately 1 in 4000) and the lower 
and upper values are fully user-programmable using the keypad (2) or the software 
provided (section 8). In the case of oxygen, three output mode options are 
provided for setting the outputs, in order to give the user maximum flexibility: 
 
1. LIN (ppm):  The linear oxygen output mode setting produces an output that is 

scaled linearly between 0 and 5V (or 4 and 20mA).  So, for example, if the 
scale is set 0V = 0% O2 and 5V = 100% O2 then 2.5V would indicate an 
oxygen reading of 50% O2.  The scaling of this example is shown in the 
following plot, from which other intermediate values can also be read.  This 
setting is more suitable for medium to high ranges of oxygen, or where the user 
wishes to monitor oxygen over a narrow range. 
 



Cambridge Sensotec Rapidox 2100ZF Oxygen Analyser Instruction Manual 
 
 

 
 
Version 3.7 13 Last printed 11/02/2014 17:40:00 
 

"Lin(ppm)"
Linear output mode

0

1.25

2.5

3.75

5

0 10 20 30 40 50 60 70 80 90 100

O2 (%)

O
2 V

ol
ts

 o
ut

pu
t

4

6

8

10

12

14

16

18

20

O
2 m

A 
ou

tp
ut

 
Figure 6: Graph showing the linear output mode option for oxygen 

The following general formulae can be used to calculate the oxygen from the 
voltage or current outputs when set to the linear output mode: 
 
Output type Formula for calculating oxygen from analogue output signal 
0-5V O2 = Vout / 5 * (O2H - O2L) + O2L 

4-20mA O2 = (mAout – 4) / 16 * (O2H - O2L) + O2L 
 
Where:  O2L = user setting of oxygen for 0V or 4mA output 1 

O2H = user setting of oxygen for 5V or 20mA output 1 
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

1 O2, O2L and O2H must all be in the same units. 

 
2. LOG (ppm):  This setting produces an output that is scaled logarithmically 

between 0V and 5V (or 4 and 20mA).  So, for example, if the scale is set to 0V 
= 0.0001% (1 ppm) and 5V = 100% (1000000 ppm) then 2.5V would indicate 
an oxygen reading of 0.1% (1000 ppm).  This scale is more suitable for large 
ranges of oxygen down to very low ppm levels.  Note that because the scaling 
is logarithmic 0V cannot be set to 0% oxygen since log(0) is -∞!  The lowest 
permitted setting is 0V = 10-20 ppm (or 10-24 %) O2.  The scaling of this example 
is shown in the blue line in following plot, from which other intermediate 
values can also be read.  For comparison, the red line shows the limitations of 
using the linear oxygen output mode over the same range. 
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Figure 7: Graph showing the logarithmic output mode option for oxygen (blue) compared with 

linear mode (red). 

 
The following general formulae can be used to calculate the oxygen from the 
voltage or current outputs when set to the log output mode: 
 
Output type Formula for calculating log10(O2) from analogue output signal 

0-5V log10(O2) = Vout / 5 * log10(O2H / O2L) + log10(O2L) 
4-20mA log10(O2) = (mAout – 4) / 16 * log10(O2H / O2L) + log10(O2L) 

 
Where:  O2L = user setting of oxygen for 0V or 4mA output 2 

O2H = user setting of oxygen for 5V or 20mA output 2 
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

2 O2, O2L and O2H must all be in the same units. 

Note: O2 = 10 log(O2) 

 
3. RAW (mV):  This setting is for certain customers who like to monitor the raw 

sensor EMF signal.  The signal from a sensor goes from approximately -50mV 
at 100% O2 through zero at approx 5% O2 and to +1000mV at extremely low O2 
levels.  So, for example, if the scale is set to 0V (output) = -50mV (sensor 
voltage at approximately 100% O2) and 5V (output) = 250mV (sensor voltage at 
approximately 1ppm O2) then 2.5V would indicate a sensor voltage of 100mV.  
The scaling of this example is shown in the following plot, from which other 
intermediate values can also be read. 
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Figure 8: Graph showing the raw sensor mV output mode option for oxygen 

 
The following general formulae can be used to calculate the oxygen sensor raw 
voltage (O2mV) from the voltage or current outputs when set to the raw sensor 
voltage output mode: 
 
Output type Formula for calculating sensor mV from analogue output signal 

0-5V O2mV = Vout / 5 * (O2mVH - O2mVL) + O2mVL 
4-20mA O2mV = (mAout – 4) / 16 * (O2mVH - O2mVL) + O2mVL 

 
Where:  O2mVL = user setting of oxygen mV for 0V or 4mA output  

O2mVH = user setting of oxygen mV for 5V or 20mA output  
Vout = the measured voltage output in volts 
mAout = the measured current output in mA 

 
The auxiliary outputs can be set to Temperature or AuxIn (Pressure or Dewpoint).  
The first option will output the value read from the thermocouple when attached.  
The second option will output the value read from the attached auxiliary sensor. 
 
To modify the oxygen analogue output range scroll down the menu to option 5 
“Set Outputs” and press ENT.  Use the UP & DOWN arrows to select the output 
type either “lin(ppm)”, “log(ppm)” or “raw(mV)” and press ENT.  You can now edit 
the lower and upper values using the UP & DOWN and RIGHT arrows.  Once 
programmed the new values remain in the memory until they are edited again in 
the future. 
 
To select and modify the auxiliary outputs scroll down to menu option 5 “Set 
Outputs” and press ENT four times.  Use the up and down arrow buttons to 
choose between “Temperature” or “AuxIn” and press ENT.  If “Temperature” is 
selected then you can change the low and high range using the same procedure 
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described above.  The range is set between 0°C and 1250°C.  If “AuxIn” is selected 
then the permissible range is the full scale of the sensor attached. 
 
Note that if the auxiliary output is assigned to temperature and the temperature 
units are set to “None” then the outputs will be set to 0V and 0mA. 
 
Note that the voltage (0 to 5V) and current (4 to 20mA) outputs are locked 
together, so that these outputs cannot be set independently of each other.  In 
normal operation therefore, 0V output always corresponds to 4mA and 5V always 
corresponds to 20mA output. 
 
During initial warm up of the Rapidox when the display reads the serial number 
the output sent to the rear terminal for oxygen will stay at 2mA (0.625V) which is 
the standby signal.  If at any stage a sensor becomes disconnected internally, or 
the signal exceeds the measurable range for that sensor, then the display will 
indicate there is a fault and the outputs will change to 1mA (0.3125V) which is the 
sensor fault signal.  This will recover as soon as the sensor is reconnected and the 
fault cleared.  Additional current and voltage signals are provided by the analyser 
to give an indication of various conditions and these are described in Table 4 
below, together with the status of the alarms during the condition: 
 

O2 Analogue Outputs 
Description Explanation Alarms (3) Current (1)  

(4-20mA) 
Voltage (2)  
(0-5V) 

1mA 0.3125V Fault 

There is a sensor fault on the oxygen 
sensor, and/or the auxiliary input 
sensor type is pressure and pressure 
mode is set to automatic (pressure 
compensation active) and the pressure 
sensor has a fault condition. 

De-activated 

2mA 0.625V Start up The analyser is still initialising or the 
O2 sensor is going to temperature. De-activated 

2.5mA 0.78125V Sensor under range The O2 sensor reading is under range. Active 
3mA 0.9375V Sensor over range The O2 sensor reading is over range. Active 

3.5mA 1.09375V Sensor operating out of 
specification 

The O2 sensor reading is in range but 
the auxiliary sensor type is pressure 
and the pressure mode is set to 
automatic (pressure compensation 
active) and the pressure sensor is out 
of range. 

Active 

4 to 20mA 0 to 5V Normal operating output 

The O2 sensor is operating normally 
and readings are in range.  If the 
auxiliary input sensor type is pressure 
and the pressure mode is set to 
automatic (pressure compensation 
active), then that is also working 
normally and its readings are in range. 

Active 

Aux Analogue Outputs 
Description Explanation Alarms (3) Current (1)  

(4-20mA) 
Voltage (2)  
(0-5V) 

1mA 0.3125V Fault The assigned sensor has a fault or is 
missing. De-activated 

2mA 0.625V Start up The analyser is still initialising. De-activated 

2.5mA 0.78125V Sensor under range The assigned sensor reading is under 
range. Active 

3mA 0.9375V Sensor over range The assigned sensor reading is over 
range. Active 

4 to 20mA 0 to 5V Normal operating output The assigned sensor is operating 
normally and readings are in range. Active 

Table 5: Analogue output settings and alarm status for certain conditions 
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Notes: 
1 The current outputs are active self-powered outputs - they are not loop powered. 
2 The voltage (0 to 5V) outputs produce non-zero voltages during start-up, fault and over/under range conditions - if 

1V to 5V outputs are required, with these conditions indicated by corresponding voltages between 0V and 1V, the 
current outputs can be used with a 250 Ohm load resistor. 

3 Alarms are de-activated during start up initialisation, and when a fault condition occurs on the assigned sensor.  If 
assigned to the oxygen sensor, alarms are also de-activated when going to temperature. 

4 If the oxygen sensor is under range, and the oxygen range is not already set to LOW, the oxygen range should be 
changed to a lower range, until the under range condition no longer occurs. 

 

7.8 Setting the Display Units 
 
The notation used by the display is fully programmable to suit your needs using 
the keypad (2) or the software provided.  The following options are available to 
you: 
 
 

1. Oxygen:  The oxygen reading can be displayed in percent (e.g. 20.95%), 
ppm (e.g. 0.01ppm) or scientific (e.g. 2.095E+05ppm see Table 4).  If 
percent is selected the Rapidox will display oxygen as a percentage down to 
0.1% and ppm below this value.  At values less than 1ppm the display 
switches to scientific notation for the remainder of the range.  There are 
also options to display the oxygen reading in terms of a pressure (units will 
be the same as the units selected for pressure) or a nitrogen balance (%N2) 
reading.  In this case the reading displayed is 100-O2% =N2 so for example 
in air 21% the nitrogen balance reading will display 79% N2.  Note that this 
is NOT an actual nitrogen reading. 
 

2. Temperature: The thermocouple reading can be displayed in Celsius (°C) 
or Fahrenheit (°F).  There is an option to display “None” which keeps the 
second line of the LCD blank if the second line is set to display 
temperature. 
 

3. Pressure: If an optional pressure sensor is attached to the Auxiliary socket 
(4) the reading can be displayed in mbar, bar, psi, torr or kPa. 
 

4. Dew-Point:  If an optional dew-point sensor is attached to the Auxiliary 
socket (4) the reading can be displayed in °Cdp,  °Fdp or ppm(V). 

 
To programme these options scroll down to menu no. 6 “Set Units” and press 
ENT.  Use the ENT key to progress through the list and the UP & DOWN keys to 
select the required units.  Once selected press ENT to store and return to the main 
menu. 
 

7.9 Setting the Display Options 
 
The user can select the LCD refresh rate and the parameter displayed on the 
bottom line using the keypad or the software provided.  Scroll down the menu to 
option no. 7 “Set up Display” and press ENT.  Use the UP & DOWN arrows to 
select either the LCD refresh rate or Line 2 Options: 
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1. LCD Refresh Interval:  The frequency of the display update can be selected 
from 0.1 to 1.5 seconds.  The current setting can be edited using the same 
method as described previously.  Once edited press ENT to store and return 
to the main menu.  The default setting is 0.3 seconds. 
 

2. Line 2 Options:  The information displayed on line 2 of the LCD can be 
chosen by the user.  The options are Temperature (displayed 0-1250°C or 
°F), Auxiliary (displayed in mbar, bar, psi, torr or KPa when a pressure or 
vacuum sensor is fitted or °Cdp, °Fdp or ppmV when a dew-point sensor is 
fitted), Alternate T/A (both temperature and the auxiliary sensor are 
displayed alternately) or the date and time (the date is displayed in local 
format and the time as HH:mm:ss).  Use the UP & DOWN arrows to select 
the required option and press ENT to store and return to the main menu. 
 

7.10 Operating Mode 
 
The Rapidox has some additional features to enable the unit to work in helium gas 
mixtures or in vacuum systems as described below.  These can be programmed 
using the keypad on the front panel or the software provided.  The default setting 
is “Normal”. 
 

7.10.1 Helium 
 
Helium presents a challenge to the analyser because of the high thermal 
conductivity of the gas.  In normal mode the heater setting is not powerful enough 
to cope with the cooling effects of helium, so the “Helium Mode” should be 
selected.  This allows the Rapidox to operate with helium flowing over the sensor.  
The analyser will give good readings in helium but the following points should be 
noted: 
 

1. The sensor response time is slightly reduced compared to oxygen operation 
2. The sensor will require a new calibration to operate correctly in helium (i.e. 

using helium calibration gases) 
3. The sensor will tend to overshoot when changing gas compositions rapidly 

as it needs more time to cool and heat up. 
4. The Rapidox will not function properly in other gases (e.g. air) whilst in 

helium mode.  Only helium mixtures should be used. 
 
When the helium mode is selected it is normal for the Rapidox to enter cooling 
mode and then briefly go back into heating mode until the new heater setting is 
reached and settles down.  The same happens when returning to ‘normal’ mode of 
operation.  When helium mode is selected the symbol “” appears on the top line 
of the display alongside the word “O2” to remind you. 
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7.10.2 Vacuum 
 
This option allows the user to operate the Rapidox as though it were a vacuum 
gauge.  The sensor will respond to changes in vacuum in the same way as changes 
in oxygen.  So for example if the vacuum is increased to 500mbar (-500mbar 
gauge) then the sensor will change from 20.95% to 10.5% as there is a linear 
relationship between vacuum and oxygen partial pressure.  However the following 
points should be noted: 
 

1. The assumption mentioned above is only valid if the vacuum pump is 
removing all gas molecules in the same ratio.  Otherwise there will be a 
disagreement.  This is normally the case but if a gas such as argon is used 
then this tends to be removed preferentially by vacuum pumps because of 
the large molecule size. 

2. The sensor should be attached to the vacuum system using one of the 
special vacuum fittings available from Cambridge Sensotec. 

 
The sensor will respond well in moderate vacuums but under very high vacuum 
in the presence of hydrocarbons (e.g. from the vacuum pump mist) the sensor can 
suddenly give extremely low readings.  This is caused by the organics reacting 
with the tiny amount of oxygen remaining.  All the oxygen is effectively burnt in 
close proximity to the sensor and the sensor will give a spuriously low reading. 
 
To programme the mode of operation scroll down the menu to no. 8 “Operating 
Mode” and press ENT.  Use the UP & DOWN arrows to select the required mode: 
Normal (factory default for oxygen measuring), Helium (for use in helium gases) & 
Vacuum (for use in vacuum systems).  Press ENT to store the mode into memory 
and return to the main menu.   
 

7.11 Pressure Mode 
 
With an optional pressure sensor attached to the auxiliary input the user has the 
option of using the reading from the sensor to correct for changes in gas pressure 
and hence oxygen pressure.  A manual pressure correction value for ambient 
pressure conditions can also be entered to improve accuracy of the correction 
(factory setting is 1013 mbar).  To access this function scroll down to menu option 
9. “Pressure Mode” and press ENT.  The desired mode can then be selected using 
the UP & DOWN arrows and pressing ENT to store and return to the menu.  The 
two modes available are: 
 

1. None: This is the factory setting.  If this mode is selected then there is no 
pressure correction performed on the oxygen reading.  The pressure and 
oxygen sensor act independently.  If the sensor is working in air (20.95%) 
and the pressure is doubled to 2 bar then the reading will also double to 
41.9%.  This is the correct oxygen partial pressure in air at 2 bar since there 
is a simple linear relationship between pressure and concentration. 
 

2. Auto: If the Auto mode is selected then the Rapidox takes then reading 
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from the pressure sensor and corrects the oxygen partial pressure to 
maintain a concentration reading.  The sensor AND pressure sensor must 
both be located in the same gas line or apparatus for this function to be 
meaningful.  If the sensor is working in air (20.95%) and the pressure 
sensor is fitted in-line then if the pressure suddenly jumped to 2 bar the 
oxygen reading would remain at 20.95% because the sensor has been 
corrected for the pressure change.  This allows users who are working with 
fluctuating pressures to maintain a ‘meaningful’ reading of oxygen 
concentration that will only be affected by changes in gas composition and 
not gas pressure. 

 
Note that when this mode is activated the user will be asked to enter a value for 
the current ambient pressure to improve the accuracy of the correction.  The 
factory default is 1013mbar which is the average ambient pressure for the UK.  
The ambient pressure at your location will depend on altitude and prevailing 
weather conditions. 
 
Note that if the pressure sensor is disconnected or fails to operate during operation 
with Auto compensation enabled, then the LCD will display “FAULT Press.” on 
the second line, and the analyser will automatically suspend Auto compensation 
while the fault exists.  The pressure sensor should be reconnected or replaced.  If 
the fault occurs when the pressure mode is set to “None” the “FAULT Press.” 
message is only displayed if the second line of the LCD is set to display pressure. 
 
Note that Auto pressure compensation is also suspended if the auxiliary sensor 
type is set to “None”. 
 

7.12 Setting the Baud Rate 
 
If you are using the software for data logging you can choose the communications 
speed (Baud Rate) by scrolling down the menu to no. 10 “Set Baud Rate” and 
using the UP & DOWN arrows to select either 9600 or 57600.  Press ENT button 
again to store and return to normal operation.  The default factory setting is 57600.  
The supplied Rapidox data logging software automatically detects the current 
setting when connecting.  If you are using other software, make sure that its baud 
rate matches the one selected otherwise you won’t be able to communicate with 
the Rapidox. 
 

7.13 Setting Date & Time 
 
The date and time can be programmed either using the software programme or 
from the menu on the analyser itself.  Scroll up to menu option no. 11 “Set Date/ 
Time” and press ENT.  The current date is displayed as “Date: dd/mm/yy” with the 
flashing cursor under the year.  The prompts at the bottom of the screen indicate 
what to do: use the UP and DOWN arrows to change the value above the flashing 
cursor and press ENT to progress.  The cursor always starts under the year value 
as this will dictate how the months behave e.g., during a leap year.  Once all the 
values are programmed correctly press ENT to change the time and finally ENT to 
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return to the main menu.  If you make a mistake at any time you can press ESC to 
return to the main menu and then press ENT again.  Note that if you re-
programme the date and time using the software then this will overwrite any 
changes you have just made and will use the current date and time of the PC. 
 
Note that the exact date format will depend on the country you are in and the 
language and local settings of the PC which you have used to connect to the 
analyser: in order to set the local date format, use the “Utility” drop-down menu in 
Cambridge Sensotec’s Rapidox data logging software, and “Set date and time”.  So 
for example in the USA you would now see the date as mm/dd/yy.  The local date 
format will be stored along with the date and time in the Rapidox. 
 

7.14 Auxiliary Sensor Configuration 
 
The auxiliary socket (4) on the front panel is used to connect the optional 
pressure, vacuum or dew-point sensor.  Before using this function make sure the 
auxiliary socket has been programmed correctly.  Scroll down to menu option 12 
“Aux In Setup” and press ENT.  At the prompt use the UP & DOWN arrows to 
select either “Pressure” for a pressure (or vacuum) sensor, “H2O” for a dew-point 
sensor or “None” if nothing is connected.  Press ENT again to set the 4mA and 
20mA range of the sensor being used following the directions given previously. 
 
Attach the sensor cable using the 3-way Cannon type socket and the reading will 
be displayed on the second line of the LCD.  If this does not happen then you must 
select the correct display option using the instructions in section 7.9. 
 
The auxiliary sensor can be used as a totally independent sensor or in the case of 
the pressure sensor can be used to correct for oxygen partial pressure measured by 
the oxygen sensor.  This is explained in section 7.11.  The scale of the pressure 
sensor (e.g., 0-10 bar) can be programmed by the user to allow different sensor 
heads to be used. 
 

7.15 Type K Thermocouple 
 
The type K thermocouple (supplied) is connected via the socket on the rear panel 
(7).  When fitted correctly the LCD display will show the temperature in °C.  If this 
is not the case then you need to select the display option in the menu system as 
described in 7.9.  Press ENT and scroll down to no. 7 “Display Setup”.  Press ENT 
to access and then press the DOWN arrow to select “Line 2 Options”.  Press ENT 
to access this menu.  Select “Temperature” (or “Alternate T/A” to alternate the 
temperature and auxiliary sensor readings) and press ENT to confirm.  The display 
should now read the temperature.  If you want to display the temperature in °F 
instead of °C select option 6 “Set Units” on the menu and press ENT again to 
access “Temperature”.  Select the desired units (or “None” to disable the 
temperature sensor) with the UP & DOWN arrows and press ENT to proceed to the 
next step.  You must complete settings for all sensors and press ENT in order to 
save the settings and return to the main menu. 
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The thermocouple is an independent measurement from the oxygen sensor, and it 
is not necessary to have it connected for oxygen measurements.  The 
thermocouple can be positioned anywhere you desire but typically it is placed in 
close proximity to the oxygen sensor so the measurement gas temperature may be 
recorded.   The type K thermocouple measurement displays 0 to 1250°C and is 
accurate +/- 1%. 
 

7.16 RS232 / RS485 Port 
 
It is possible to factory set the data communications port to either RS232 or 
RS485.  Once configured at the factory it is not possible to change unless the unit 
is returned to Cambridge Sensotec Ltd. 
 
Data from the Rapidox is sent on demand to the 9-way 'D' type socket (8) on the 
rear panel and can be read using a simple terminal programme such as 
'HyperTerminal' in Windows, or with the user's own custom software.  
Alternatively a simple and convenient data logger programme is included with the 
supplied software and is described in section 9 below. 
 

7.16.1 RS232 Protocol 
 
Oxygen data can be read from the RS232 port at the back of the Rapidox.  The 
default RS232 configuration is 57600-8-N-1, as shown in this example for COM1: 
 

 
Figure 9: Rapidox default COM properties box 

 
Alternatively, the baud rate can be reduced to 9600 via the “Set Baud Rate” menu 
item, using the front panel keypad on the Rapidox.  This setting is stored in 
EEPROM. 
 
Connection:  Connect to RS232 socket at the back of the Rapidox using a 9 way D-
type plug.  Signals are as follows: 
 
Rapidox D-type Socket:  PC/PLC: 
Pin# 2 = Data Out   Data In (RX) 
Pin# 3 = Data In   Data Out (TX) 
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Pin# 5 = Common/Gnd -- Common/Gnd 
 

 
 

Figure 10: Rapidox RS232 pin configuration 

 
All other pins (1,4,6,7,8,9) = Don’t care 
 
Reading Data:  Data is read using command “D”.  Send the single character “D” to 
the Rapidox.  The Rapidox replies with one of the following responses.  All valid 
responses end with [CR] & [LF] (where [CR] = ASCII 13  and [LF] = ASCII 10).  
 
Response: !Initialising[CR][LF] 
Meaning: Rapidox is still initialising 
 
Response: !Sensor heating[CR][LF] 
Meaning: Rapidox is still heating sensor to operating temperature 
 
Response: !Sensor cooling[CR][LF] 
Meaning: Rapidox is still cooling sensor to operating temperature.  This can 

happen when switching from Normal to Helium operating mode. 
 
Response: !Cleaning sensor[CR][LF] 
Meaning: Rapidox has finished heating sensor and is cleaning the sensor for 5 

seconds 
 
Response: !User setup active 
Meaning: The configuration menu has been activated via the front panel 

keypad.  The menu will automatically time out 60 seconds after the 
last key was pressed, or press the keypad’s ESC key to return 
immediately to normal run mode. 

 
Response: !Possible sensor fault 
Meaning: The sensor has failed to reach operating temperature within 10 

minutes from power up.  This may be due to the age of the sensor, or 
because a high thermal conductivity gas is being used. 

 
Response: !No sensor or sensor fault[CR][LF] 
Meaning: Sensor is not connected, or there is a fault in the sensor 
 

 
 
 
 
 

RS232 

5 4 3 2 1 

9 8 7 6 
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Response: d2.959E+05,-1.426E+01,2.000E+00,3.619E+01,23:19:40,14/01/00, 
M,,AL1&2[CR][LF] 

Meaning: “d” means data is being sent  
 “2.959E+05” is Oxygen reading in ppm 
  “,” = data separator 
 “-1.426E+01” is Oxygen sensor reading in mV 
 “,” = data separator 

“2.000E+00” is pressure sensor reading in bar, or dew-point sensor 
reading in °Cdp (if connected) 

 “,” = data separator 
 “3.619E+01” is temperature sensor reading in °C 
 “,” = data separator 
 “23:19:40” is Rapidox time  
 “,” = data separator 
 “14/01/00” is Rapidox date in DD/MM/YY format  
 “,” = data separator 
 “M” is the current oxygen “range” setting (L,M,H) 
 “,” = data separator 
 “,” = data separator 
 “AL1&2” means both alarm conditions 1 and 2 exist ** 
 [CR] = ASCII 13 (Carriage Return character) 
 [LF] = ASCII 10 (Line Feed character) 
 
** If no alarm conditions exist, this data is empty, so the response would look 

like:  
  
d2.959E+05,-1.426E+01,2.000E+00, 3.619E+01,23:19:40,14/01/00,M,,[CR][LF] 
 
Response: ? 
Meaning: “D” command was not recognised.  Try to send it again. 
 

7.16.2 RS485 protocol 
 
Please contact Cambridge Sensotec for further information on this feature. 
 

7.17 Printing 
 
If you have purchased the printer option then you have the option to print out 
various data from the analyser straight on to thermal paper.  Simply connect the 
printer to the unit using the serial socket (10) on the rear of the machine and make 
sure the printer is switched on (battery and mains versions are available).  To 
print the live values on the LCD at any time simply press the RIGHT arrow button 
on the front panel.  Each push of the button will print out the serial number 
followed by the data in a tabbed format followed by a blank line.  If the button is 
held down, the printer will keep printing data (but not the serial number). 
 
If the last four digits of your firmware version number are 09.03 or greater, then 
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when first connected or switched on, the printer will print out the machine serial 
number and firmware versions.  If you do not have a printer connected and you 
attempt to print using the RIGHT arrow button you will get the error message: 
“Unable To Print”. 
 

7.18 Load Defaults 
 
It is possible to restore the machine back to its factory settings by loading the 
unique default configuration that is supplied on your software CD-ROM.  The 
default set-up can only be accessed using the software provided.  Please see 
section 8.4 for further details. 
 
Alternatively, you can reset to ‘generic’ factory defaults directly from the front 
panel keypad.  Press ENT to enter the user setup menu and select menu option 13 
“Load Defaults” and press ENT to proceed.  The next screen will say “Load 
Defaults?” with the prompt to press and hold ENT for 2 seconds to confirm.  To 
complete this press the ENT button until the bar graph has completed and the 
screen says “Defaults Loaded”.  This will give you all the basic settings that are 
factory set.  You will now need to re-calibrate the sensor and check all the settings 
are suitable. 
 

7.19 Replacing the Sensor 
 
After extended use the sensor will being to fail and will need replacing.  Normally 
this is caused by the sensor heater failing.  The Rapidox sensor will not be able to 
reach its operating temperature anymore and the message “Sensor Heating” will 
appear on the display permanently when the sensor is located in fresh air.  Note 
that this effect can also happen if the sensor is being operated in hydrogen or 
helium.  Please contact Cambridge Sensotec for advice before replacing the sensor. 
 
A new sensor can be simply connected to the front connector (3) of the analyser as 
shown in Figure 4.  The sensor is available in pre-calibrated and non-recalibrated 
versions.  If you have a non-recalibrated sensor then the analyser will require a 
full recalibration as soon as the new sensor is up to temperature.  If on the other 
hand you have purchased a pre-calibrated sensor then you simply connect it in 
place and switch on, and then load the accompanying rxc file using the software.  
This procedure is described in section 8.5 below.  Only once the correct updated 
rxc file has been loaded into the analyser is it fully recalibrated and ready to take 
measurements. 
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8. Rapidox Software Instructions 
 

8.1 Software Installation 
 
It is possible to programme a range of variables to the Rapidox using an RS232 (or 
RS485 if configured) link with a PC running MS-Windows (all versions) and the 
supplied Rapidox software.  The software is installed automatically by inserting 
the Rapidox CD into the CD-ROM drive.  If auto-installation does not start then 
you can click the Windows START button and select RUN.  Type X:\setup.exe 
where X is the drive letter of your CD.  Alternatively access the CD from Windows 
Explorer or the ‘My Computer’ icon on your desktop, and double-click on the 
‘Setup.exe’ programme.  Follow the on-screen instructions to install the 
programme onto the hard drive.  Once installed, you can access the programme by 
clicking START - PROGRAMS – Rapidox Software. 
 
The software has been tested successfully on most language machines including 
Chinese, Korean & Japanese and all current versions of Windows operating 
system.  We do not recommend the use of Vista as connecting devices to this 
operating system can be problematical at best. 
 
Note that software is ‘regionally aware’ and will therefore accept and display data 
using the decimal separator that is set in the PC’s Regional Settings in the Control 
Panel.  For example, in the UK or US, you might enter the value 2.5 - in 
continental Europe this would normally be entered as 2,5 assuming the PC’s 
Regional Settings have been set up to use ‘,’ as the decimal separator. 
 

8.2 Getting Started 
 
Make sure that the Rapidox is connected to a free serial port on the rear of your 
computer.  These will nearly always be COM1 or COM2 but the software will scan 
through the first 16 ports until it finds the Rapidox.  The analyser must be 
switched on for this to succeed and while you are communicating with it.  You 
can programme the variables without a sensor attached, but to monitor the 
Rapidox properly, the sensor needs to be connected and at operating temperature.  
On start up the software will locate the Rapidox and display the following page: 
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Figure 11: Configuration 1 page.  Note the actual values used may differ from those shown above. 

 
The yellow status box at the bottom will display confirmation that the Rapidox 
was found and the result of the last action, or any error messages if there is a 
problem with communication.  If you experience problems check that your serial 
cable (supplied) is correctly fitted to a valid serial port, and that you do not have 
another application open that may be using the same port.  There are several types 
of serial cable available.  You must use a cable as supplied where there are straight 
through connections, i.e., pin 2 to pin 2, pin 3 to pin 3 and pin 5 to pin 5.  Other 
cable formats will not work.  Also check the status of your COM port settings in 
Device Manager accessed by clicking START – Settings - Control Panel. 
 

8.3 On-Screen Help 
 
You can access the on-screen help facility at any time by clicking on the ‘Help’ 
menu on the menu bar and select the ‘Help’ option or press F1. 
 

8.4 Configuration Page 
 
The configuration page is split into three, and you can switch between them by 
clicking on the tabs labelled “Config 1”, “Config 2” or “Alarm Config”.  Each page 
allows the user to reprogramme an array of variables used by the Rapidox.  Once 
written to the Rapidox, the new variables remain permanent until overwritten. 
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To read the current configuration stored in your Rapidox select ‘Read Analyser 
Configuration’ from the ‘File’ menu, or click the ‘Read’ button on any of the 
‘Config’ pages.  Note that the entries in the boxes on the RHS (under the ‘Write’ 
button) will turn red if the value is different to that just read and a red asterisk 
will appear next to the ‘Write’ button to warn you that a change has been made.  
The left-hand set of grey text fields (‘read fields’) will be updated with the current 
configuration data.  To save this information (e.g., if several people share the same 
instrument) click the long copy (‘>>’) button (between the ‘Read’ and ‘Write’ 
columns) on any of the ‘Config’ pages in order to transfer the data into the edit 
boxes, select ‘Save Configuration as’ from the ‘File’ menu and choose a filename.  
This data set can be subsequently reloaded at any time by selecting ‘Load 
Configuration File’ from the ‘File’ menu and then selecting the folder where the 
configuration files have been stored. 
 
If at any time you wish to restore the machine to its factory default settings select 
‘Default Configuration’ from the ‘File’ menu to load these values.  The software 
will search for a unique ‘.rxc’ file that is loaded onto the PC during the software 
installation.  The filename is 2100***.rxc where *** is the last three digits of the 
serial number located on the rear of the machine.  This file is also located on the 
CD-ROM that came with the machine.  Normally this file is located in the “My 
Documents” directory but if the software cannot locate it then it will ask you for 
the serial number to help it search.  With the correct rxc file loaded into the ‘Read’ 
columns, simply click ‘>>’ (copy) to transfer the defaults into the edit boxes and 
then click any of the three ‘Write’ button to load them back into the Rapidox. 
 
The right-hand set of white editable text fields (‘write fields’) is used to enter new 
values to be programmed into the Rapidox.  The values in these fields can either 
be entered manually, or copied across from the ‘read fields’ by clicking the vertical 
‘Copy’ button, and then edited as required, however greyed boxes under the 
‘Write’ buttons are not editable as they contain calibration data; they can only be 
changed by copying data across from the ‘Read’ fields.  Note that when you click 
on the copy button all three ‘Config’ pages are updated at the same time and there 
is no need to repeat the action when you toggle to the other page.  Alternatively, 
you can load saved configuration data by selecting ‘Load Configuration’ from the 
‘File’ menu and selecting the required file.  In order to programme the analyser 
select ‘Write configuration to the analyser’ from the ‘File’ menu, or click the ‘Write’ 
button on any ‘Config’ page. 
 

8.5 Replacing a Pre-Calibrated Sensor 
 
If you are replacing the oxygen sensor for a new one and you have purchased a 
pre-calibrated sensor then this will be supplied with a memory stick containing 
the updated rxc file.  The rxc file contains the new calibration values matched to 
the new sensor and it is important to load this as soon as possible once the sensor 
has been changed over.  Place your memory stick into the PC and run the software 
so that it connects with the Rapidox unit.  Select ‘File’ and ‘Load Configuration’ 
and select the location of your USB memory stick.  The filename is 2100***.rxc 
where *** is the last three digits of the serial number located on the rear of the 
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machine.  With the updated rxc file loaded into the ‘Read’ columns, simply click 
‘>>’ (copy) to transfer the defaults into the edit boxes and then click the ‘Write’ 
button to load them back into the Rapidox.  The yellow status bar will show you 
that the update was successful.  Your new sensor is now correctly calibrated and 
ready to use without using any specialist cal gases. 
 

8.6 Reconfiguring the Analyser 
 
The on-screen edit boxes contain variables that can be reprogrammed into the 
Rapidox in exactly the same manner as using the front panel keypad.  For a full 
description please refer to the relevant section in this manual. 
 
The user can choose whether to use ppm or percent notation to edit the text boxes, 
where appropriate, by selecting the ‘UNITS’ menu and clicking on ‘Percent’ or 
‘ppm’.  To access a field, either click inside it or use the TAB key to scroll through 
them.  The field parameters are as follows: 
 

8.6.1 Config 1 Screen 
 
1) Oxygen Range:  See section 7.5 for a full description.  Use the drop down 

box to select LOW, MEDIUM or HIGH.  The default setting is Medium. 
 

2) Oxygen Units & Format: See Section 7.8 for a full description.  Use the 
drop down box to select PPM EXPONENTIAL, PPM MIXED, AUTO%/PPM, 
PRESSURE or N2 BALANCE %.  The default setting is AUTO%/PPM. 
 

3) Oxygen Analogue Output Mode:  See section 7.7  for a full description.  
Use the drop down menu to select either mV, LINEAR(ppm) or LOG(ppm).  
The default setting is linear (ppm). 
 

4) Temperature Units/Enable: See sections 7.8 and 7.15 for a full description.  
Use the drop down menu to select °C, °F or NONE.  If ‘None’ is selected 
then the temperature display is completely disabled.  The default is °C. 
 

5) Pressure Units: See sections 7.8 and 7.14 for a full description.  Use the 
drop down menu to select MBAR, BAR, PSI, TORR or KPa as the unit for 
pressure measurement.  The default setting is MBAR. 
 

6) Pressure Correction Mode: See section 7.11 for a full description.  Use the 
drop down menu to select NONE or AUTOMATIC.  The default setting is 
NONE. 
 

7) Operating Mode:  See section 7.10 for a full description.  Use the drop 
down menu to select NORMAL, HELIUM or VACUUM.  The default setting 
is NORMAL. 
 

8) Auxiliary Output Parameter: This function allows the user to choose 
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whether the Auxiliary output terminals on the rear panel (6) are for use 
with the thermocouple (7) or the optional auxiliary sensor (4).  Use the drop 
down menu to select TEMPERATURE or AUXILIARY IN.  The default 
setting is TEMPERATURE. 
 

9) LCD Refresh interval:  Use the drop down menu to select a refresh rate for 
the LCD (min 0.1, max 1.5 sec).  The default is 0.3 seconds. 
 

10) LCD Second Line Option:  See section 7.9 for a full description.  Use the 
drop down menu to select TEMPERATURE, AUXILIARY IN, 
TEMP/AUXILIARY IN (alternating), DATE/TIME (alternating).  The default 
setting is TEMPERATURE. 
 

11) Auxiliary Sensor Type: See section 7.14 for a full description.  Use the 
drop down menu to select either NONE, PRESSURE or DEW-POINT.  The 
default is NONE unless an auxiliary sensor is ordered with the Rapidox and 
in this case the correct sensor type will be selected. 
 

12) Humidity Units: See section 7.8 for a full description.  Use the drop down 
menu to select either °Cdp, °Fdp or ppm(V).  The default is °Cdp.  Note that 
this menu option only appears if the selected sensor is dew-point. 
 

13) Password Protection:  See section 7.2 for full details.  Use the drop down 
menu to either enable the password or disable the function.  Note that if the 
function is already enabled then you will need to enter the password when 
prompted to do so, in order to continue.  You can change the password 
when prompted as well.  Contact Cambridge Sensotec if you are having 
problems remembering the password. 
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8.6.2 Config 2 Screen 
 

 
Figure 12: Configuration 2 screen. Note the actual values used may differ from those shown 

above. 
 

14) Calibration Gas 1, 2 & 3: These boxes are greyed out in this version and 
the data is for information purposes only.  If you want to change the current 
calibration gas then follow the procedure given in section 8.7. 
 

15) Calibration Constant A B & C:  These boxes contain the calibration 
constants that the Rapidox calculates automatically when you perform a 
calibration.  You will see that they change each time you perform a new 
calibration.  Generally the air value should be approximately -10mV and a 
low ppm value (eg 10ppm) would be approximately 180mV. 
 

16) O2 Analogue Output (0V/4mA & 5V/20mA):  Use these two boxes to set the 
High and Low oxygen values for the analogue outputs (6) on the rear panel.  
For example if you want 4mA to represent 1% and 20mA to represent 21% 
then enter these two values into the appropriate boxes.  The value can be 
entered either in % or ppm depending on the units selected.  The default is 
%.  The default values are 25% for the high setting and 0.001% for the low 
setting.  However, if the ‘Oxygen Analogue Output Mode’ on the ‘Config 1’ 
page is set to ‘Raw mV’ then the values entered are in mV. 
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17) Auxiliary Analogue Output (0V/4mA & 5V/20mA):  Use these two boxes to 
set the High and Low auxiliary values for the analogue outputs (6) on the 
rear panel.  For example if you want 0V/4mA to represent 0°C and 5V/20mA 
to represent 1250°C (for temperature) then enter these two values into the 
appropriate boxes.  The units are automatically determined by the settings 
made for the auxiliary sensor type. 
 

18) Absolute Ambient Pressure: Use this box if you want to enter the current 
ambient pressure (in mbar).  This value is used in the automatic pressure 
correction function only and provides enhanced accuracy in the correction.  
The default is 1013mbar which is the average ambient pressure in the UK. 
 

19) Auxiliary Sensor Range: Use these two boxes to set the range of the 
auxiliary sensor.  If the sensor type is pressure or vacuum then enter in 
terms of mbar or if it is a dew-point sensor then enter in terms of °Cdp.  
Make sure that the scale here matches the scale printed on the auxiliary 
sensor otherwise errors will occur in the readings. 
 

20) Oxygen and helium impedance setting:  These values are for information 
purposes only and cannot be adjusted.  They control the temperature of the 
heater for the two modes of operation by setting the impedance of the 
zirconia cell to a pre-determined value.  These values are only displayed in 
the engineering version of the software. 
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8.6.3 Alarm Config Screen 
 

 
Figure 13: Alarm configuration screen.  Note the actual values used may differ from those shown 

above. 

 
21) Alarm Source: Use the drop down box to assign a detector to the alarm.  If 

you want the alarm to be based on oxygen readings select oxygen from the 
drop down list.  The choices are: oxygen, auxiliary in (pressure, vacuum or 
dew-point type) or temperature. 
 

22) Alarm Outputs:  This option enables or disables the alarms on the rear 
panel (labelled Alarm High +/- and Alarm Low +/-).  Make sure these are 
enabled if you wish to use the signals from the alarm circuit. 
 

23) Audible Alarm:  This option enables or disables the audible buzzer fitted to 
the Rapidox internally.  When an alarm condition occurs the buzzer will 
emit a continuous noise to alert the operator. 
 

24) Visible Alarm:  This option enables or disables the visual warning on the 
front LCD.  When enabled and an alarm condition occurs the message 
“AL1” or “AL2” will flash in the lower right hand corner. 
 

25) Rising or falling Alarm: This option allows the alarm to be set as a rising or 
falling type.  If the alarm is rising then the reading must rise above the set-
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point for the alarm to be activated.  If the alarm is falling then the reading 
must fall below the set-point for the alarm to activate. 
 

26) Contacts N/O or N/C:  This option allows the user to programme how the 
relay contacts are set on the rear panel.  Normally Open means that the 
contacts are open circuit when an alarm is not activated and Normally 
Closed means that the contacts are closed when the alarm is not activated. 
 

27) Alarm Setpoints: Use this box to programme the set-point value at which 
you want the alarm to activate.  The units are in %, ppm °Cdp or mbar 
depending on which sensor you have assigned to the alarm. 

 
Once you have finished editing the parameters, select ‘Write Configuration to 
Analyser’ from the ‘File’ menu (or click the ‘Write’ button) and the new data set 
will be written to the Rapidox.  The Rapidox is reprogrammed using the new 
configuration.  The software then reads the new settings back from the Rapidox 
and displays them in the boxes on the left-hand side confirming that the 
configuration was successful.  When you have finished programming the analyser 
for new calibration gases you must recalibrate the instrument to benefit from the 
changes. 
 

8.7 On-Screen LCD 
 
It is possible to display an LCD emulator on the desktop of your PC.  This 
reproduces exactly the display on the Rapidox unit and is convenient if you are 
some distance away from the machine.  To activate the LCD, select the ‘Utilities’ 
menu and select the ‘Show LCD’ option.  This will display a small window 
showing the LCD, that can be positioned independently anywhere on the desktop. 
 

 
Figure 14: On-screen LCD.  Values shown are for illustrative purposes only. 

 
The blue LED indicator will flash to show that the display is updating. 
 

8.8 Remote Calibrating and Cleaning 
 
With the on-screen LCD display active it is possible to remotely calibrate the 
analyser and clean the sensor.  Click on the down arrow icon in the bottom right-
hand corner of the LCD display to expand the window: 
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Figure 15: Remote calibration and clean function. Values shown are for illustrative purposes 

only. 

 
Use the four buttons to calibrate or clean the sensor directly from the PC.  Before 
calibrating the analyser with gas, make sure that you know the exact O2 
concentration in your gas bottle AND you have a calibration certificate from the 
gas supplier confirming the concentration.  You can calibrate the analyser in any 
order but remember that the gas value for O2 High must be greater than the gas 
value for O2 Middle, which must be greater than the gas value for O2 Low.  Allow 
sufficient time for the calibration gas to pass over the sensor and let the reading on 
the LCD stabilise.  This is extremely important to perform a successful and 
accurate calibration. 
 
The software uses the three calibration gas values already stored in the Rapidox as 
a starting point.  These are typically High = 20.95%, Middle = 0.1% and Low = 
0.001% as set in the factory but may be different if the user has recalibrated with 
other gas values in the past.  Either way you are given an option to change the cal 
gas value before proceeding to the actual calibration. 
 
Assuming you are using fresh air (20.95%) to calibrate O2 High then simply click 
on the button labelled “Calibrate High O2” to see the following: 
 

 
Figure 16: Calibration Gas Confirmation Screen. 

If the current stored value is correct and matches your cal gas value then simply 
click “Yes” to proceed.  If you are using a different value to the one you see on the 
screen then click “No” to change it as shown below: 
 

 
Figure 17: Calibration Gas Update Screen. 
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Enter your new value in the units as instructed and click “OK” to proceed.  This 
value will then be stored until you want to change it again.  You will now see the 
following screen: 
 

 
Figure 18: Calibration Confirmation Screen. 

 
This is your final chance to change your mind before committing to a calibration.  
Check carefully that the gas value on the screen actually matches the value of your 
calibration gas before clicking on “Yes” to complete the calibration.  At this point 
you should observe that the LCD display will reset itself to the correct calibration.  
You can now proceed with the rest of the calibration process by selecting the 
Middle and Low gases in the same manner. 
 

8.9 Calibration Error Messages 
 
During the calibration process described in 8.7 above it is possible to receive 
screen error messages as described here. 
 

1) Bad Sensor Reading:  The Rapidox software makes a prediction of the 
expected sensor mV for each calibration gas value entered.  If the mV signal 
coming from the sensor is out of the expected range the following message 
is displayed: 
 

 
 
This normally indicates one of two things: that you are using the wrong cal 
gas value compared with the actual gas flowing over the sensor OR the 
sensor is getting old and can no longer output the expected signal required 
for a healthy calibration. 
 

2) Bad Pressure Reading:  The Rapidox software checks to see what the gas 
pressure is before allowing the calibration to continue.  If the pressure is 
outside the range -25mbar to +25mbar (gauge) then the following message 
is displayed: 
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This normally indicates that you are allowing gas from a cylinder set at too 
high pressure to enter the analyser.  Try displaying the pressure reading on 
the second line of the LCD and adjusting the gas regulator to trim it close to 
0 mbar.  If you are using a standard gas regulator then try switching off the 
sample pump on the rear of the analyser OR better still use a demand flow 
regulator and allow the gas to enter the analyser from the draw of the 
pump. 

 
Note that the above are only advisories and you can proceed with the calibration if 
you believe everything is checked and correct. 
 

8.10 Software Utilities 
 
The utilities menu is located on the main file menu as shown below: 
 

 
Figure 19:  Software Utilities Menu 

8.10.1 Setting Analyser Date and Time 
 
The current date and time of your PC are displayed on the configuration screen 
and can be loaded into the Rapidox by selecting the Utilities menu and clicking 
the ‘Set date and time’ option.  This information is used in the RS232 data string 
for data logging purposes.  Make sure that your PC clock is set correctly before 
using this function, as you cannot edit the date and time shown by the Rapidox 
software.  The date and time formats displayed are those set in the PC’s Regional 
Settings. 
 

8.10.2 Check for Updates 
 
This function will check online and advise you if any software updates are 
available for your machine.  This function is not automatic.  To update the 
software you need to visit www.cambridge-sensotec.co.uk and select the support 
page where a list of downloads are provided. 

http://www.cambridge-sensotec.co.uk/
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8.10.3 Image Grabber 
 

This is a simple function to allow the user to copy the software screens into the 
Windows clipboard.  This is useful for diagnosing problems; allowing a quick and 
simple way of sending the Sensotec technicians actual screen shots of the 
software.  To recover the images simply press CTL+V to paste. 
 

9. Rapidox Data Logging Software 
 

9.1 Introduction 
 
The Rapidox software includes a full data logging facility.  Data can be saved to a 
file automatically at regular intervals and the format is compatible with 
spreadsheet programmes such as MS-Excel.  A live-time graphing facility is also 
included which has many powerful features.  Note that the data logging facility 
will only function if the analyser is in run mode: in any other mode (e.g., user 
menu active or sensor heating) logging will be suspended until the analyser 
returns to normal run mode. 
 

9.2 Setting up the Data Logger 
 
Click on the tab labelled ‘Data Acquisition’ to display the following page: 
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Figure 20: Data Logging page 

 
During logging, data from the analyser is shown in the central area of this page.  
The data is displayed in the following columns: time (in seconds, minutes or 
hours, according to the setting of the ‘Read every’ drop-down box), the raw signal 
from the sensor (in mV), the oxygen value (in ppm scientific notation), pressure in 
mbar (if pressure sensor is attached) or dew-point in °Cdp (if a dew-point sensor is 
attached), the type K thermocouple reading (in Celsius), the time (in HH:MM:SS 
format), the date (in regional format), and analyser status (displaying the oxygen 
range setting, the operating mode and “AL1”, “AL2” or “AL1&2” if one or both 
alarms are activated). 
 
To start data logging select the frequency of measurement by entering a time and 
selecting a unit from the drop down list.  For example if you wish to log data once 
every minute type 1 in the box labelled ‘Read every’ and select ‘Mins’ from the 
drop down menu. 
 
You can open the NOTES window at any time by selecting ‘Notes’ from the ‘Data 
Logger’ drop down menu.  A small text box appears in which you can type a text 
message.  This note is then saved as a header in the data file set and can be viewed 
along with the data. 
 
You can either choose to have data logged continuously until ‘Stop’ is selected 
from the ‘Data Logger’ menu, or you can choose to set a time limit for data logging 
by checking the box labelled ‘Time Limit’, and then setting the duration in the 
‘Run For’ box and selecting units with the drop down list.  For example if you 
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wish to log data for thirty minutes type ‘30’ in the box and select ‘Mins’ from the 
drop down list. 
 

9.3 Running the Data Logger 
 
If you wish to save the data into a file for later use, check the ‘Save to File’ box 
before selecting ‘Run’ from the ‘Data Logger’ menu.  You will be prompted for a 
file name and location before data logging commences.  The file and path 
information will appear in the box at the top of the page labelled ‘Data File Name’.  
If you forget to select file saving before starting a run, you will nevertheless be 
prompted at the end as to whether you wish to save the run data. 
 
The blue progress bar displays the state of completion of the run, and the blue box 
to the right of it displays the same information as a percentage.  You can stop the 
run at any time by selecting ‘Stop’ from the ‘Data Logger’ menu.  The yellow Status 
bar at the bottom of the page gives information about the data logging operation. 
 
Once data logging is complete you may open the text format data file using any 
compatible spreadsheet programme such as MS-Excel, and use the data to 
generate plots and reports.  You can save files with a “.txt” extension (the factory 
default) or a “.csv” extension, and whichever was last used will become the new 
default.  See section 10.21 “Working with Spreadsheets” for more on this topic. 
 
You can pause the data logger at any time by selecting ‘Data logger’ and ‘Pause’.  
Click ‘Data logger’, ‘Resume’ to continue logging from where you left off, noting 
that the clock keeps ticking during the pause period. 
 

9.4 Auto Date Stamped Files 
 
If you are planning to run the data logger for extended periods of time then you 
should consider checking the ‘Auto date stamped file’ option.  This feature will 
save the data at midnight for the previous twenty four hours and so on until the 
data logging is complete OR the user interrupts it.  The data file is stored with a 
date suffix in brackets in yy-mm-dd format. 
 
This feature ensures that data is saved periodically in sensible sized files.  This 
will prevent the computer from crashing and will also ensure that the data is small 
enough to fit into an MS-Excel spreadsheet 
 
As an example, the user wishes to run the data logger for seven days recording 
every minute starting at lunchtime on 12th November 2005.  He starts the data 
logger with the auto-date stamp function enabled.  When prompted he gives the 
filename as “test1.txt”.  In this situation the data logger will run from lunchtime to 
midnight and then save the first file as “test1 (2005-11-12).txt”.  The data logger 
then clears and continues for another twenty four hours until midnight the 
following day.  The data is then stored as “test1 (2005-11-13).txt”.  This will 
continue for seven days when the data logger will finish. 
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After this the user will have a sequence of files: 
 
test1 (2005-11-12).txt 
test1 (2005-11-13).txt 
test1 (2005-11-14).txt 
… 
 
And so on.  Combined together they represent all the data over the last seven days.  
Note that the Rapidox uses the computer clock and date to perform this action, so 
make sure that they are correct before starting a run. 
 
To view the data in its entirety the user would need to load each file in turn back 
into e.g., MS-Excel to combine them. 
 

9.5 Live-Time Graphing Screen 
 
The Rapidox data logging package includes a live-time graphing facility that 
allows you to monitor the progress of your data in a graphical format (see Figure 
21).  To access the graph check the box labelled ‘Show Graph’.  The graph will 
appear in a new window, and can be accessed at any time without disturbing a 
run that is already in progress.  You can select  ‘Run’ and ‘Stop’ from the ‘Data 
Logger’ menu in the graphing window to begin and end data logging, and the 
window can be minimised to (and restored from) the task bar while logging data.   
 
To close the window and return to the main data logging page select ‘Close Plot’ 
from the ‘File’ menu or click on the close window button. 
 
The features of the graph window are described below: 
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Figure 21:  Live-time graphing screen 

 

9.6 Main Graph Window 
 
The graph is an XY plot, with time plotted on the X-axis, oxygen plotted on the 
primary Y-axis (Y1) and temperature or Auxiliary sensor (if connected) plotted on 
the secondary Y-axis (Y2).  The X-axis and the two Y-axes auto-scale during data 
logging so that all data points are shown on the graph. 
 

9.7 Plot Colours 
 
The default colours used on the graph are set to blue for oxygen and red for 
temperature.  To change the colours double-click on the coloured axis label at the 
top of each axis.  A colour palette window will appear (see Figure 22) and a new 
colour can either be chosen from a colour box, or for more variety, by clicking the 
‘Define Custom Colours >>’ button.  Click on ‘OK’ to select the new colour or 
‘Cancel’ to return to the graph without change. 
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Figure 22: Plot colour palette menu accessed by double-clicking on the axes titles. 

 

9.8 Graph Titles and Labels 
 
If you want to change the text of the graph axis labels, place the mouse pointer 
over the text and do a single left click to enter edit mode.  The text can then be 
modified.  Similarly, to change the title of the graph, place the mouse pointer over 
the title and click once to edit.  If you choose not to enter a title the graph will 
display the path and filename of the run as the new title once the run has 
finished.  Note that these changes are only temporary and will be overwritten by 
the defaults if a new run is started or the graph window is closed and reopened.  
They are provided so that the plot may be printed with alternative labels. 
 

9.9 Plot Co-ordinates 
 
The box labelled ‘Plot co-ordinates’ to the upper left of the graph window displays 
the actual plot co-ordinate value at the mouse pointer.  This can be used to get a 
quick oxygen value from the graph.  Simply place the mouse pointer at a place of 
interest and read the corresponding X1 and Y1 values in the box. 
 

9.10 Last data point 
 
During data acquisition, the box labelled ‘Last data point’ will appear at the upper 
middle of the graph window.  It displays the last data values read from the 
analyser. 
 

9.11 Using the Cursor 
 
Clicking and holding the left mouse button with the pointer over the ‘C’ at the top 
of the plot area activates the cursor, which appears as a vertical dashed line on the 
plot. While keeping the mouse button pressed, you can now move the pointer 
anywhere in the plot area or on the ‘C’ in order to move the cursor.  The box 
labelled ‘Cursor’ to the upper right of the graph window will display actual values 
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for oxygen, temperature, time and the data point number (n) at or immediately to 
the left of the cursor position.  The cursor can be used to investigate actual data 
values at specific points of interest on the graph. 
 

9.12 Zooming 
 
You can zoom in to any part of the oxygen plot by simply placing the mouse 
pointer on the new graph start position and then clicking and dragging a new box 
to re-size the graph.  The label on the box to the upper left of the graph window 
will change to ‘Zoom box co-ordinates’, and an extra set of co-ordinates, labelled 
X2 and Y2, will appear, showing the co-ordinates in X and Y units of the second 
corner of the zoom rectangle as you drag the mouse pointer.  The plot will zoom 
and auto-scale when you release the mouse button.  This can be repeated if you 
wish to zoom in even further.  To zoom back to the original size select ‘Zoom Full’ 
from the ‘View’ menu. 
 
Note that although you can use the zoom facility during a live run, the graph will 
auto-scale to full size with each new data point. 
 

9.13 Y-Axis Graph Units 
 
You can toggle the Y1 oxygen units at any time from percent to ppm and vice 
versa.  Select ‘O2 Units’ from the ‘View’ menu and choose either percent or ppm.  
The current selection is then displayed in the top right box labelled ‘O2 Axis’. 
 

9.14 Oxygen Scale 
 
You can display the Y1 oxygen axis in linear or logarithmic format at any time by 
selecting ‘O2 Scale’ from the ‘View’ menu. The current selection is then displayed 
in the top right box labelled ‘O2 Axis’.  Note that the zoom function is disabled 
when you are viewing on a log scale. 
 

9.15 Second Y Axis 
 
The secondary Y axis located on the right hand side of the graph can be used to 
display either temperature taken from the type K thermocouple, pressure taken 
from the pressure sensor or dew-point taken from the dew-point sensor fitted to 
the Auxiliary socket on the front.  It is not possible to display temperature and 
pressure / dew-point at the same time.  The axis is linear and auto-scaling.  To 
select the mode of the secondary axis select ‘View’ and then ‘Second Axis Display’.  
Choose from ‘None’, ‘Temperature’, ‘Pressure’ or ‘Dew-point’. 
 

9.16 Loading an Old Run 
 
A previously logged data file can be loaded and viewed by selecting ‘Open Data 
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File’ from the ‘File’ menu and selecting the appropriate TXT or CSV file.  A 
progress bar is displayed while the data is being imported.  Note that very large 
data files may take several seconds to load.  The data is re-graphed and you can 
zoom, label axes, change colours etc., before printing the graph. 
 

9.17 Printing Graphs 
 
You can print the graph at any time by selecting ‘Print Plot’ from the ‘File’ menu.  
This will bring up the printer dialogue box for your specific printer where you can 
choose various printing options.  Make sure that the printer page is set to 
landscape to obtain a full size print out. 
 

9.18 Data Logging in the Background 
 
It is possible to begin data logging and then minimise the windows in order to 
continue working with another application.  To minimise the graph simply click 
on the minimise button on the blue title bar at the top of the window.  You can 
then use the ALT + TAB keys to take you to other programmes already running.  
To return to the graph simply maximise from the start menu bar or press ALT + 
TAB again.  If the graph does not redraw immediately select ‘Zoom Full’ from the 
‘View’ menu to redraw. 
 

9.19 Pausing the Data Logging 
 
You can pause the data logging at any time during the run by selecting the ‘Data 
Logger’ menu and selecting ‘Pause’.  Repeat the action to continue, noting that the 
live graph will draw a straight line between the paused points to keep continuity 
of the axes.  The clock keeps ticking during the pause period. 
 
If you decide to access the menu of the Rapidox using the front keypad during 
data logging, then the software will pause automatically.  A message appears on 
the screen informing the user that the unit is being accessed from the keypad.  
Once the menu has been exited, the software will continue data logging from 
where it left off.  The clock keeps ticking during the pause period. 
 

9.20 Changing the Data Logging Parameters Mid-run 
 
Once the data logging has begun it is not possible to modify the original total 
length of time that the data logging will run for, but you may change the sample 
interval time by pausing the data logger and then entering a new value for the time 
interval.  The data logger can then be resumed with the new values in place.  Note 
that you can not change units (e.g. seconds to hours) once logging has started.  If 
you originally selected seconds then you may change the current value to a new 
value between 1 and 3600 seconds, if you originally selected minutes then you 
may change between 0.02 and 360 and if you selected hours you may change 
between 0.01 and 6 hours.  You can of course stop the run at any time using the 
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‘Data Logger’, ‘Stop’ menu option. 
 

9.21 Working with Spreadsheets 
 
The data logger saves data files in a standard comma separated ASCII text format 
which can be readily imported into spreadsheet programmes such as MS-Excel, in 
order to produce plots and reports as desired.  For specific information on how to 
import text files into your spreadsheet programme please refer to the help guide 
supplied with the programme. 
 
Data is saved in comma separated value format, with a ‘.txt’ file extension as the 
initial programme default.  However, when entering the file name, you can instead 
select a ‘.csv’ extension: the programme will register the last used file extension as 
the new default.  The ‘.csv’ extension is recognised by MS-Excel, so that opening 
the file will automatically run MS-Excel, and this may be of benefit if your 
regional decimal separator is period ‘.’ rather than comma ‘,’.  However, if your 
decimal separator is comma, you should continue to use the ‘.txt’ extension and 
open the file explicitly from within your spreadsheet programme, defining the 
field delimiter as ‘comma’ where appropriate. 
 

9.22 Disaster Recovery 
 
To prevent catastrophic loss of important data during a computer crash or power 
failure, the data is automatically saved point by point in a temporary file called 
‘Rapidox temporary data file 2100xxx.txt’, where 2100xxx is the serial number of 
your Rapidox.  This file is located in the “My Documents” folder and can be 
renamed or copied to recover data that would otherwise be lost.  Note that this file 
is overwritten each time ‘Run’ is selected from the ‘Data Logger’ menu so make 
sure all data is recovered successfully before starting another run. 
 
Note that during a run using the ‘auto date stamped’ feature, the temporary data 
file is wiped clean as soon as the previous data set has been saved successfully.  In 
the case of a crash the temporary data file should be used to recover the last day’s 
worth of data that was not saved to the hard disc. 
 

9.23 Diagnostics 
 
The Rapidox software includes a diagnostics page that is accessed from the tab 
labelled ‘Diagnostics’.  This screen will display various values and settings that are 
operating inside your machine.  There is no editing possible on this page – it is 
purely for information and to enable technical support help you should you 
experience difficulties with your machine.  You may be asked to record values 
from this page if trouble shooting is required. 
 



Cambridge Sensotec Rapidox 2100ZF Oxygen Analyser Instruction Manual 
 
 

 
 
Version 3.7 47 Last printed 11/02/2014 17:40:00 
 

 
Figure 23: Rapidox Diagnostics Page 

 
1. Analogue:  The live analogue values displayed in this pane are voltage 

measurements coming directly from the computer chip inside the analyser.  
They are for information purposes only but are a useful diagnostics tool for 
Sensotec staff, as unusual values can indicate a particular fault.  To help 
Sensotec diagnose a fault please capture this window as shown above using 
the screen capture function described in section 8.9 above and e-mail it to 
support@cambridge-sensotec.co.uk  
 

2. Sensor State:  These boxes should all indicate “OK” on a healthy analyser.  
Note that the temperature probe needs to be connected on the rear panel (7) 
in order to test here.  The possible messages are “OK” “High” “Low” or 
“Fault”.  The High and Low messages indicate that the sensor is out off 
normal range.  The fault message will only display if the sensor is 
disconnected or has failed in some way. 
 

3. Digital:  The digital signals coming directly from the computer chip inside 
the analyser can be monitored here.  To test the keypad is working correctly 
try pushing the buttons and watching the panel.  A correctly functioning 
key will turn the box red on the screen and the digital value for that 
particular key will show in the data box.  If the analyser has an external 
thermocouple correctly fitted (2100 and 3100 series only) then this will 
display a signal in the “Temperature Sensor” box. 
 

4. Log Diagnostic Data:  Log Diagnostic Data:  If you check this box then the 
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software will automatically start to save a diagnostic file in the “My 
Documents” directory called “Rapidox diagnostics data XXXX.txt (where 
XXXX is the serial number of your machine).  Note the following: 
 

• Diagnostic data is logged every 6 seconds, or every second if your software 
has the "Enable fast log" check box. 

• Logging diagnostic data is controlled entirely by the "Log diagnostic data" 
check box - logging starts as soon as it is checked, and stops when it's 
unchecked. 

• If you switch to a different tab diagnostic data logging will be suspended, so 
the general rule when logging diagnostic data is check the "Log diagnostic 
data" check box and then leave the software alone until you want to stop 
logging. 

• There is no file name option, so rename the last diagnostic data file before 
logging new diagnostic data. 

• Diagnostic data contains raw data from the analyser as well as either status 
messages (such as "Sensor heating") or acquisition data as you would get 
from the normal data acquisition file.  However, unlike normal data 
acquisition, it isn't suspended if the heater loses control.  Diagnostic data 
saving will only be suspended if there's a comms glitch between the PC and 
the Rapidox, or if you try to interact with the Rapidox via software.  The file 
is created at the start of the run, and as with the temporary data file, each 
data line is appended, so you can look at the file at any time.  You can 
therefore have a look at the file at any time (for example by opening it in 
Notepad or by copying and saving it with a .CSV extension for Excel) and 
see whether there are any anomalies. 

 
E-mail the file to support@cambridge-sensotec.co.uk so we can help diagnose the 
problem. 
 

10. Troubleshooting 
 
Q: The Rapidox says 'sensor heating' but won't begin measuring. 
A: Check to see if the sensor is getting hot.  If it is then make sure the cable 

plug is located firmly in the socket (2).  If you are still having problems 
contact Cambridge Sensotec for advice.  If the sensor stays cool then the 
internal heater has failed and the sensor needs replacing.  This problem can 
also occur if you are using helium gas without selecting the helium mode in 
the menu. 

 
Q: The Rapidox won't power up at all. 
A: There are fuses located on the power socket on both live and neutral lines.  

These are standard 20mm slow blow 2A fuses available from a supplier 
such as RS Components. 

 
Q: The Rapidox gives strange readings that are way off the expected values. 
A: Check to make sure which three calibration gases are selected.  Are they the 
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same as the actual gases you used to perform the calibration?  If not you can 
change their values using the software.  Also check to see that the pressure 
sensor is working correctly and is measuring the same pressure as the 
oxygen sensor is being exposed to, if the pressure correction mode is set to 
‘Auto’. 

 
Q: The sensor does not read 20.9 - 21.0% in air (actual value is 20.95%). 
A: If the room air is very humid, it will slightly affect the observed 

measurement or the sensor may have drifted slightly because of natural 
ageing.  If you are using air as a calibration point then simply do a quick re-
calibration in the air to compensate for this. 

 
Q: I messed up the calibration procedure and the analyser is not working 

properly. 
A: Return the box to the factory defaults using the instructions given in section 

7.18 
 
Q: The date and time information on the RS232 is incorrect. 
A: The date, time and other features are user-programmable via the 

configuration software, or via the front panel using the built-in 
configuration menu.  If using the software, make sure that the time and date 
are correct on the PC you are using before attempting to reprogramme the 
Rapidox.  Also, the date format must be set via the software, and uses the 
setting from the PC that was last used to set the date and time.  The factory 
default date format is DD/MM/YY. 

 
Q: The software will not talk to the Rapidox. 
A: Make sure that you are using the correct cable, as supplied (pin 2 to pin 2 

etc).  A crossed RS232 cable (pin 2 to pin 3 etc.,) will not work.  Make sure 
that your COM ports are recognised by your computer.  Check in your 
Windows device manager to see if there are any conflicts.  If you have an 
internal modem fixed to your PC you may experience difficulties using this 
software.  Contact Cambridge Sensotec for further advice. 
 

Q: I selected ‘Write Configuration to Analyser’ and now the Rapidox is way off 
calibration. 

A: Only select ‘Write Configuration to Analyser’ once all the values are 
correctly entered in the boxes on the right.  The best procedure is to ‘Read 
Analyser Configuration’ and then press ‘Copy’ so the values in the boxes are 
the same as those stored in the Rapidox memory.  You can then edit these 
values and then select ‘Write Configuration to Analyser’ when finished. 

 
Q: How do I get back to the factory calibration for my instrument. 
A:  Select ‘Load Configuration File’ from the ‘File’ menu and look for the 

“2100xxx.rxc”  file on your CD, where “2100xxx” is the serial number of 
your unit.  Select this file and then select ‘Write to the Analyser’.  This will 
load the factory calibration back into the Rapidox.  Alternatively you can 
use ‘Default Configuration’ on the ‘File’ menu which will automatically try 
to load “2100xxx.rxc”. 
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11. Warranty 
 
The Rapidox analyser has been carefully tested and inspected before shipment 
and is guaranteed to be free from defective materials and workmanship for a 
period of twelve months from date of purchase and delivery.  The sensor head is 
replaceable and has a life expectancy in excess of 17,500 hours.  However, if the 
analysis gas contains corrosive gases or large quantities of particulates, sensor life 
may be shortened.  In the case of the latter, it is normally possible to insert a filter 
prior to the sensor head to remove the particulate material. 
 

11.1 Conditions of Warranty: 
 
1) This warranty is in addition to and does not affect any statutory rights of 
consumer purchasers.  This warranty is valid worldwide on a “back to base basis”. 
 
2) This warranty covers breakdowns due to design or manufacturing faults; it does 
not apply to damage, however caused, wear and tear, neglect, unauthorised 
adjustment or repair, or any items of limited natural life. 
 
3) In the event of failure, please take the following action: 
 

a] Refer to the “Troubleshooting” section of your instruction manual to 
identify and possibly correct the problem. 
 
b] If the fault cannot be resolved, please contact the Cambridge Sensotec 
service and repair centre at the address given on the cover of the manual. 

 
4) The warranty period applicable shall be 12 months from the date of delivery 
provided that: 
 

a] Notice in writing of the defects complained of shall be given to Cambridge 
Sensotec (The Seller) upon their appearance, and 
 
b] such defects shall be found to have arisen from the Seller's faulty design, 
workmanship or materials, and 
  
c] The defective goods shall be returned to the Seller's premises at the 
Purchaser's expense if so requested by the Seller. 
 
d] Any repaired or replaced goods shall be redelivered by the Seller free of 
charge to the original point of delivery but otherwise in accordance with and 
subject to these Conditions of Sale. 

 
e] Alternatively the Seller shall be entitled at its absolute discretion to refund the 
price of the defective goods in the event that such price shall already have been 
paid by the Purchaser to the Seller, or, if such price has not been so paid, to 
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relieve the Purchaser of all obligation to pay the same by the issue of a credit note 
in favour of the Purchaser in the amount of such price. 
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Aux out: Aux In
(prompts 6)

 (Options: Aux In, Temp.)

0.000E+00  = 0V
(prompts 3)

1.250E+03  = 0V
(prompts 3)

1.250E+03  = 0V
Outputs set

Edit Value

Edit O2(ppm)

Oxygen: Auto %
(prompts 6)

® ®

®®®

®®

®

®

 (Options: Auto %, Pressure, N2 Bal %,
Exp ppm, Auto ppm)

Temperature:°F
(prompts 6)

H2O: ppmV
(prompts 5)

H2O: ppmV
All units set

 (Options: °C, °F, None)

Pressure: psi
All units set

Displays message for 1.5 seconds

Displays message for 1.5 seconds

Pressure: bar
(prompts 6)

 (Options: ppmV, °Cdp, °Fdp)

®®®

®ENT

 Auxiliary In
set to H2O

Line 2 Options
(prompts 2)

Refresh Interval
(prompts 2)

L2:Auxiliary
(prompts 5)

Interval: 0.3 s
(prompts 5)

L2: Auxiliary
Line 2 set

Interval: 0.3 s
LCD refresh set

ENT

Displays message for 1.5 seconds

®

®

®

®

®

8-Operating Mode
(prompts 1)

Mode: Normal
(prompts 5)

Mode: Normal
Mode configured

Displays message for 1.5 seconds

ENT® ®

ESC

ESC

ESC

®

­

­

­

­

­

­

Continued from page 1 Back to Measurements.

4-Set Alarms
(Prompts 1)

Set: Alarm 1
(Prompts 2)

Assign to: O2
(Prompts 2)

(Options: O2, Temp. AuxIn)

Outputs: On
(Prompts 6)

(Options: On, Off)

Audible: On
(Prompts 6)

Visible: On
(Prompts 6)

Polarity:
(Prompts 6)

(Options: On, Off)(Options: On, Off) (Options:

(Options: Alarm 1, Alarm 2)

1.000E+01
(Prompts 3)

Change Set Point

Contacts: N/O
(Prompts 6)

(Options: N/O, N/C)

ESC

®

®®®

® ® ®

®

® ®

­

®

Contacts: N/O
Alarms set

ENT

®®

®®

Displays message for 1.5 seconds

ESC - Back to Menu List. No changes

®

®

®

®

®

®

ENT

ENT

ENT

ENT

ENT ENT

ENT

ENT

ENT

ENT

ENT

ENT

ENT

ENT

ENT

ENT

ENT

ENT

ENTENT

ENT

ENT

ENT

ENT

®

®

®®



Prompts 1: Prompts 2: Prompts 3: Prompts 4: Prompts 6:

ENT = OK
ESC = Back

Prompts 5:

 = Change
ENT = Next
ESC = Back

 = Change
ENT = OK
ESC = Back

 = Change
® = Select Char.
ENT = OK
ESC = Back

 = Scroll Menu
ENT = Next
ESC = Back

 = Scroll Menu
ENT = Next
ESC = Exit

Edit password

­

Enter password - default is 0000 (Options: Enable, Disable, Change)

 Enable or Disable selected

®

®®

­

14 - Password Menu
(Prompts 1)

Password: 0***
(prompts 3)

Password: Enable
(prompts 2)

Password: Enable
PW Enabled

ENT ENT ENT ® ®
ESC

Password: 6234
(prompts 3)

 Back to Menu List : Changes Applied

®®

Wraps around to Page 1

 (Options: 9600, 57600) Displays message for 1.5 seconds

®

­

­

­

Baud rate: 57600
(prompts 5)

Baud rate: 57600
Baud rate set

10-Set Baud Rate
(prompts 1)

ENT ENT

11-Set Date/Time
(prompts 1)

®

12-Aux Setup
(prompts 1)

Continued from page 2

Date: 07:08:10
(prompts 6)

Date: 07:08:10
(prompts 6)

Date: 07:08:10
(prompts 6)

Time: 16:38:10
(prompts 6)

Time: 10:55:30
Date/time set

Displays message for 1.5 seconds

Set Year Set Month Set Day

Time: 16:38:10
(prompts 6)

Time: 16:38:10
(prompts 6)

Set Hours Set Minutes Set Seconds

®

® ®

® ®

®

®

Type: H2O
(prompts 5)

1.200E+01 °Cdp
(prompts 3)

2.1000E+01 °Cdp
(prompts 3)

2.1000E+04 mbar
Aux sensor set

Displays message for 1.5 seconds (Options: H2O, Pressure, None) Edit 4mA value Edit 20mA value

® ® ® ®

None selected ®®

ESC

ESC

ESC

 Back to Measurements.

ENT

Displays message for 1.5 seconds

®®

Edit Ambient pressure

9-Pressure Mode
(prompts 1)

Mode: None
(prompts 5)

ENT

Mode: Auto
(prompts 3)

Mode: None
Mode configured

1.000E+03mbar
(prompts 3)

ENT

1.013E+03mbar
Pressure set

ENT ®

Displays message for 1.5 seconds

®

ESC

­

­

ESC - Back to Menu List. No changes

ENT

ENT

ENTENT

ENTENT

ENT

ENT

ENT

®®

®

®

®

®

®

ENT

ENT

®ENT

®®13-Load Defaults
(prompts 1)

Load Defaults?
(prompts 4) Defaults Loaded

Displays message for 1.5 seconds

ENT ®

 Enter for two seconds to load defaults

ESC ­

ENT
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